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Welcome to our deep dive into outlining
with Final Draft 12. First, we'll talk about the
reasons why outlining is an essential tool
in every screenwriter's toolbox. Then, we'll
take a closer look at Final Draft 12's new
outline tools and how best to apply them

to your work.
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Why should | outline my screenplay?

Most professional screenwriters will tell you the key to a successful writing process is creating an
outline. Having your story beats mapped out means that once you dive into writing your first draft, you
have the freedom to focus on character, dialogue and action, rather than worrying about where the

story is headed.

Keep in mind that having an outline doesn't mean your story is set in stone, however! Most screenplays
undergo multiple drafts from conception through the production stage. But having a roadmap means
you can enjoy the scenery along the way — in this case, your character development and devising cool
set pieces — safe in the knowledge that if you take a detour, you can always find your way back to the

main road; or goal of your story.

Film industry expectations

Alittle-known truth of the film industry is that working screenwriters are required to create outlines for
different stages of development. The language and terminology vary, but whether producers request
“a treatment”, "a take”, or “just a few pages”, screenwriters breaking into the industry can't simply talk
their way into a writing job. If a company is going to pay you to write, chances are very good they'll
ask you to map out the story first. They may request a take or a few pages first, but in most cases,
that will lead to the producers wanting you to “flesh out” your take. This process can go on for weeks
and it usually ends with you writing a treatment. Most scripts utilize the classic Hollywood three-act

structure, and thus, your treatment will likely be divided into three acts as well.
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Atits core, the three acts represent a beginning, a middle, and an end. This is further broken down into
several related scenes within each act to tell the story. These related scenes are called Sequences,

and within a sequence you will find a series of events driving your story forward, also known as Beats.

Producers and studio execs will need to know how your story begins and ends, as well as what some
of the more important Sequences and Beats that string the story together are. They are also likely to
ask the writer what the "emotional through-Lline” of the story is and what are the goals of the primary

characters. To know these essential elements, a screenwriter must create an outline.

Outlining the twists and turns

Thrillers and horrors —both popular genres —especially benefit from an outline, whether you're outlin-
ing for your own script or as a paid gig, because they often involve a mystery or twist. The best twists
don't come out of nowhere and should work with everything that's been established in the narrative,
while simultaneously not tipping off the reader. This calls for careful plotting and to do so without

mapping out the Sequences and Beats leading to your Big Reveal would be difficult.

For example, if you're writing a horror film that involves various set pieces and a “body count”, it's
a good idea to know which characters are getting dispensed and in what order. You don't want to
spend a lot of time developing a character if they're not making it to the second act (unless you're
doing Psycho-style misdirection). Also knowing what set piece your characters are going to be in-
volved in will help you to tailor certain aspects of that character for the impending set piece or
death scene.
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In many horror films, a character's primary personality flaw or obsession plays a role in their demise.
Likewise, your script's protagonist will have their issues — flaws and strengths — that should come into
play by the climax. Whether your initial inspiration is the set piece or the character, it's best to have it
worked out by the time you go to draft. Otherwise, you're likely to become lost in your own narrative
and the result will be a convoluted script in which even your best ideas don't add up in a succinct
and effective manner. Generally speaking, the more plot-driven the story, the greater the need for

an outline.

Outlining reality

The basic elements of a biopic or historical drama are the who, what, when and where, but true stories
sometimes require even more of a road map than a fictional one. Fact is, it's impossible to “wing it

when you're building a story involving a real-life person.

First, you must do research and choose which people (if any) involved in a historic event or converse-
ly which events from your chosen public figure's life you're going to use in your script. There might
already be a basic framework for you to work with, but it'd be a daunting task to create a cohesive
narrative without mapping it out beforehand, especially if you want to write something that's dramat-
ically engaging and not simply a fact-based, "cradle to grave” retelling of your subject’s life. It still
needs to work as a dramatic screenplay and as such, it must have a strong emotional through-line with
obstacles and conflict throughout. Thus, constructing a story that best accomplishes this is essential.
This will not only require months of research but a detailed outline. In general, consider that the more

complex the story, the greater the need for an outline.
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Creating a fluid outline

Although an outline is beneficial for complex or plot-driven scripts, this also doesn't mean the writer
should become anchored to the outline they've created. An outline is just that: an outline. An architect
might start with a blueprint, but real-world factors might eventually lead to a building not exactly like
the one they first envisioned. In the same fashion that a director might reshape your script when on
set, you might find the need to alter or deviate from your outline during rewrites. Not everything that
works in an outline works in a script. A moment that seemed clever in theory, might land flat or untrue
on the page. You can spend hours, if not days, trying to make it work, but if it simply doesn’t, you must

be prepared to change course and get to the next Beat or Sequence in your outline in a different way.

Think of it as going on a road trip you have mapped out with GPS. For the most part, you follow the nav-
igation, but what happens if a road is blocked, you get a flat, or simply spot something or a place you
want to check out? You don't just keep following the GPS. You go off route and know you can always

reactivate the GPS when needed.

If you're in the middle of writing your script and suddenly inspiration hits you and you think of a better
ending than what you had originally outlined, then go with it! The outline is there to assist you, not
obstruct you. A screenwriter needs to use every tool available to them and oftentimes inspiration is

the greatest tool of them all.
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Final Draft makes going from idea
to outline as easy as 1-2-3

Final Draft 12 makes going from idea to outline even easier with the Final Draft 1-2-3 workflow. Using
the 1-2-3 workflow, you can brainstorm a story on the Beat Board™, drag the Beats to the Outline
Editor™ to get a bird’s eye view of your story’s structure, then send that outline to your script, where it
can be fleshed out right on the page. While writing is seldom easy, you can use this approach to go

from idea to rough draft as easy as 1-2-3!

Let's get started.

1. The Beat Board

If you have the very beginnings of an idea, the Beat Board is a great way for you to build those ideas

into a story. You can make a Beat out of anything, whether it's one small note or an entire act.

Start a new Beat Board by opening a New Document in Final Draft 12 and selecting Beat Board view
from the Toolbar (you can also choose to start with one of our Structure Templates by choosing New
From Template and selecting the template you want to work with.) In the Beat Board simply click any-
where to create a Beat that can contain any information you want: an idea for a scene, character arcs,

plot points etc.

finaldraft.com



QUM
YOUR SCREENPLAY WITH
FINAL DRAFT 12

soe United Taogle & ioss F5 12 - Ot

[ (=0 B Owientosy ¢ el BT L ®
Cotibiion ) T e T Chamge e i s
et S et

Over time, your Beat Board should start coalescing into scenes, which you can start arranging on the

grid by using Flow Lines, or even in rows or columns.
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Once your story has taken shape on the Beat Board, you can start taking your beats to the...

2. The Outline Editor

The new Outline Editor, visible at the top of your Final Draft document underneath the Toolbar, helps

you organize your Beat Board into the story you want and get it ready to turn into a script.

Simply click and drag a beat into the Outline Editor to add it to one of the lanes. Outline 1 can be
used for big, high-level beats like acts or sequences, while Outline 2 can be more granular, or even

arranged scene by scene. Alternatively, Outline 1 and 2 are great ways to track the A Story and B Story

if you're plotting a television series script.
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You can also start determining how long each beat should run in the script by click-and-dragging the

edge of a Beat in the Outline Editor to match a page goal or range!
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Once you've assembled your Beats on the Outline Editor and feel like you're ready to transform them

into a script, you can..
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3. Send Outline to Script

While you can send individual Beats or a group of Beats to script, you can also send your entire

Outline to the script in one click!
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reach a destination misses its purpose.”

In the Outline Editor go to the Send Outline to Script button (on the panel) and click! This will
translate every Beat on your Outline Editor onto the script view and transform those Beats into

Outline Elements.
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You can follow your outline right in the script and start writing based on the outline, without having to
click between various documents or refer to stacks of notes. It's all based on your original Beat Board
and Outline Editor. You can also transform the Outline Elements into script content using the Change

Element To function.
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If you ever want to see how your script is looking, you can simply hide the outline elements by
selecting Hide Outline in Script under the View tab, and then Show Outline in Script when you want
to see your outline again. This is also a great way to make sure you're keeping to your page goals,

since hidden outline elements won't count toward your page count!

Unciied Tangie & Maus FO12 - Sorigt
=

Gumiesl 3 EENET B .
Toatup  Cwmen Tk S S N otk
acE .
T Gt T R et ey P Tav b m
R ] e o st | 6 ] e [ i

o T o 1 A, W, PRATANY | 1 12 o S

L]

CLOSE CM: A GOLD XEY L
Kajestic, light glintimg off it.

YOUSS GIRL (PRE-LAP)
And what o the kay Zer? Mhat door 2
will it open?

INT. HONEZ LIBRARY - DAT

Meat TANGLE, 12, prececices wyes, unruly hair. She gazes sut
a window of & Bouse on & Rill suEreurded by eveEqresas.

Eer merchant VNCLE, 40s, cuzved mustache perfectly grocsed,
looks cver various maps opresd acroas a large table.

@nly the Blackenith who forged the
gold kay knows u“n dwl it wnl
and he‘a

thay say, on EM otl‘.ﬁ -ldq o( the
door, 1ies & great treanure.

‘Tangle turns from the window, intrigeed by the legend.

1E (oowT'D)

Bow doen your hair get so tangled?
Evary tise I return to port, I find
you in mome grand stats of disrepair.
Shosld I ask the maids to better help
you maintain it while I's at seal

EITCHEN - NIGET (FLASEBACKE}

THREE MAIDS spin toward Tamgle, who's just entered. They're
sharing & bottle of Uszle's whiskey. Deck of cards waicisg.

sy

TR T Ve

finaldraft.com



QUM
YOUR SCREENPLAY WITH
FINAL DRAFT 12

Untitied Taoqgs & oes F0 12 - Serpt 1
(R =0 ] (=] Shet 2 0~ s~ [~ -
ol Vews Destbosst Toaege  Gerens

e A ten iy sy TAMaen | T

b s
- e o o s n o s
P g D
CLOSE CN: A GOLD NEY -
Hajostic, light glinting off it.
FOURG GIL (PRE-1AR)
And what is the key for7 Kbhat door 3
will it epen?

INT. HOME LISNARY = DAY

West TANLE, 12, precocions eyes, uaruly hair. Sha qares ont
a window o I'ou.ﬂ on a hill surrew by avargredns.

Her merchant VNCLE, 408, curved rustache perfectly groomed,
losks over various maps spresd aceoss A largs table

L
Gnly the Blacksaith who forged the
9034 Koy knows ubat dsor it opuns,
ard ko’s loag siece passed,
thoy cay, oa the othor side 0! \lw
e il great treamire.

Tangle turne from the window, intrigued by the Legend.
UNCLE {COFT'B)
tow dows your bair gut 00 tangled?
Bvory time I return to port, I find

Should I ask the maids to better help
you maintain it while i'm at soa?

cuT T8 -

KITCHEN - NIGNT (FLASNBACK)

TUREE MAIDS spin teward Tamgle, who's jat eatered. They
sharing a bottle of Uscle‘s whiskey. Dack of cards nxuny

HEAD MATD
Spask & word, we'll toss you In
this kere pot!

Tho SECOND MAID dropa a live LOBSTER into a boiling pot --
PLOPI The THIRD MAID SLANG the lid -

BACK TOn
HOME LIBRARY - PRISENT TINE
Tangle shakes hor head at Uscle: Mo saids.
i
e 4003 —— wn |

Once you've filled out your script based on your outline, guess what? You've written your first draft, as
easy as adding ideas on the Beat Board, dragging your Beats to the Outline Editor, then sending the
outline to script. Now you have an outline of your story and get to bypass the dreaded blank page -

Jjust view your outline in the script and get started adding dialogue and action!
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Using Templates in Final Draft 12

In addition to creating an outline, Final Draft 12 also offers templates that can help give you a

framework for your script.
Atemplate is a reusable document formatted to industry standards or your personal preference.

To open a new blank template, simply go to File, New from Template and from the various
categories pick the type of document you want to work on. You can choose from customized
templates to script, TV, graphic novel, and text templates. You can also choose the category Structure
to find templates based on popular structural guides like Blake Snyder's Save the Cat!, Chris Vogler's

The Writer's Journey and Dan Harmon's Story Circle.

After you've written your script, you can also change the format by applying a different template to
it. For example, you can apply a TV template to a finished feature-length script by going to Format >
Elements > Apply a Template. You can also customize a template by going to Format > Elements and
choosing the element you want to change. Once the elements have been customized you can clear
the pages and save the new template to your computer or the Final Draft template menu for easy

access.
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Learn More

For a visual tour of the Beat Board, Outline Editor, and the new outline elements in Final Draft
12, be sure to watch our various instructional videos on Final Draft's official YouTube channel
and finaldraft.com to make the most of the Story Building Tools Final Draft 12 has to offer, and

take your screenplay to a whole new level.

You can also try Final Draft 12 free for 30 days!

Visit https://trial.finaldraft.com/ to download.

Happy Outlining!
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